CENTRICITY TRAINING INDEX

CENTRICITY TRAINING INDEX .................................................................................................................. 2

DESKTOP ...................................................................................................................................................... 5
Logging In To Centricity ................................................................................................................................. 6

Desktop....................................................................................................................................................... 7
  Viewing Schedules .................................................................................................................................... 9
  Alerts/Flags and Documents from Desktop ................................................................................................. 10
  Alerts/Flags Tab from Desktop .................................................................................................................. 11
  Documents Tab from Desktop ................................................................................................................... 12
  Sending a Flag .......................................................................................................................................... 13
  Converting an Alert/Flag to a Document .................................................................................................. 16
  Finding a Patient Chart ............................................................................................................................. 17
  Logging Out of Centricity EMR .................................................................................................................. 17
  Completing the Phone Note & Routing a Document ................................................................................ 18
  Working with Quick Text ........................................................................................................................... 21
  Managing Documents ............................................................................................................................... 22

PATIENT’S CHART ....................................................................................................................................... 23
  Viewing Summary Tab ............................................................................................................................... 24
  Viewing History Tab ................................................................................................................................ 25
  Viewing Problems Tab ............................................................................................................................... 26
  Viewing Medications Tab ........................................................................................................................... 27
  Viewing Alerts/Flags Tab ............................................................................................................................ 28
  Viewing Flowsheet Tab ............................................................................................................................... 30
  Viewing Orders Tab ................................................................................................................................... 31
  Viewing Documents Tab ............................................................................................................................ 32

MENU BAR .................................................................................................................................................... 33
  Registration ................................................................................................................................................ 34
  Graphs ........................................................................................................................................................ 35
  Handouts .................................................................................................................................................... 36
  Saving Items in “My Folder” ....................................................................................................................... 37

PATIENT CHART .......................................................................................................................................... 38
  Rooming/Opening an Office Visit ............................................................................................................... 39
  Transition of Care – IN ............................................................................................................................... 41
  Rooming/Opening an Office Visit (Provider) ............................................................................................ 44
  Capturing Family History in FH/SH-CCC ................................................................................................... 45
  Capturing Family History in FH-SH/CCC (cont’d) .................................................................................... 46
  Capturing Smoking Status in Social History in FH-SH-CCC ..................................................................... 47

CPOE A&P-CCC Form and Orders .................................................................120
Signing Orders ......................................................................................121
Setting Orders to a “Complete” Status ..................................................123
Managing Lab Results ........................................................................126
  Abnormal Lab Results .......................................................................126
  Normal Lab Results ........................................................................127
  Lab Letters ......................................................................................128
WORKING IN A CHART UPDATE ..............................................................129
  Special Functions ............................................................................130
  Generating a CCD (Continuity of Care Document) ..........................131
  Decision Support Protocol ..............................................................133
SCANNING ..............................................................................................134
MESSAGING TAB ....................................................................................139
  Accessing the Messaging Tab ............................................................140
  Viewing the Messaging Tab ...............................................................141
  Composing a Secure Message ..........................................................142
    To Send a Standard Message: .........................................................142
    To Send a Patient Message: .............................................................143
    To Send a Secure Message Using a Template: .............................145
    To Send a Referral (Transfer of Care) Secure Message .................147
  Sending a Secure Message With a Patient Document via SM-Basic Encounter Type from the visit update ..........................................................149
  Logging on to Shared Inboxes ............................................................151
  Sending a Message to a Triage Folder (Save to EMR) ......................154
PATIENT PORTAL ....................................................................................155
  Patient Portal ..................................................................................156
  Logging On to the Portal ................................................................156
  Portal Registration ...........................................................................157
  Registration Consent .......................................................................157
  Create a New Portal Account ............................................................158
  Patient Verification .........................................................................159
  Identity Verification .........................................................................159
  Generating a PIN ............................................................................162
  Printing the PIN for the Patient .......................................................163
TIPS/HINTS .............................................................................................164
  Tips/Hints ......................................................................................165
  Adding Forms, Document Templates And Placeholders ...............167
  Centricity Icon Cheat Sheet .............................................................168
Logging In To Centricity

1. Type in your user name in the **User ID:** box.
2. Enter your password assigned to you at the **Password:** box. If you cannot remember your password, tell your instructor now and he will obtain it for you. At the **Location of Care:** box should default your Location of Care. If you work in multiple Locations of Care, click the drop down menu to select the correct location. Location of Cares are directly tied to the providers schedules in Centricity Business, if you choose the wrong Location of Care, the wrong schedule will be displayed.
3. If you have already been in Centricity, you should see a “Return to: Chart” checkbox on the lower left side of the Login screen. If you do not want to return to the specified area, uncheck the box by clicking once on it.
4. Click **OK.**
1. Point mouse at any cell in Alerts/Flags or Documents for “cell-peek.”
2. Organize Alerts/Flags or Documents by clicking on column headings.
3. Hold mouse over splitter bars and drag to adjust display.
4. Try out a keyboard shortcut – Press F8 to move to the next tab.
5. Notice the menus – Go, Actions, Options, Help.
6. Notice the options for Alerts/Flags and Documents on the desktop.
7. Notice ability to go to Flags and Documents Tab from desktop Summary.
8. Go to Options>Display to reset window sizes and display text and icons.
Desktop (cont’d)

Users can change their appointment view to default to a different provider.

1 Click on Go>Setup>Preferences.
2 Double click the Desktop folder and click Appointments.
3 At the “View Today’s Appointments for:” Click the to search for a provider.
4 On the Find Appointment Book window, type the provider who’s appointments you wish to view and click .
5 Highlight the desired provider from the search results and click .
6 Click the icon to view the new selected providers’ appointments.

PLEASE NOTE: Users can double click a patient displayed on the appointment list to open their chart.
Viewing Schedules

Displays the appointment book that is being viewed on the Desktop.

You can view multiple schedules by clicking the button.

- **Click the**  button.
- **Enter a provider name in Book(s): box or click the drop down menu to select a provider. Be sure to click Show Canceled Appts and Show No Show Appointments in the Organize section to view canceled and no show appointments.**
- **Click Save as Default.**
- **Click OK.**

You can also open a patient’s chart and view appointments scheduled in the future or past.

- **Click on the desired appointment.**
- **Click the Open Chart button to open the chart or click View Appointments button to see appointment scheduled in the future.**
Alerts/Flags and Documents from Desktop

Viewing Alerts/Flags and Documents from Desktop

Alerts/Flags
- Flags are messages to either individual or shared desktop
- Alerts are important notes that appear on the Summary and Alerts tab of the patient’s chart and can be viewed by specific individuals or by everyone.
- Alerts/Flags are similar to post-it notes that are not typically attached to a patients chart and are not a permanent part of the medical record; unless converted to a document

Documents
- Documents are items pending review, action, or signature by physician or staff member and are a permanent part of the patients medical record

Documents and Alerts/flags can be reviewed from the summary tab of the desktop. Documents and Alerts/flags can also be reviewed from the individual tabs on the desktop.
Alerts/Flags Tab from Desktop

Viewing Flags Tab

- **View alerts/flags to:** allows user to view other staff member’s alerts/flags. Enter the users name or click the drop down menu to select from the View alerts/flags to box.
- **The buttons** allow various functions (similar to e-mail) like reply, forward and removed to be completed.
- **The details area** explains more about the alert/flag being viewed. Date, Time, who the message is from, etc.
- **The bottom area** allows the alert/flag to be read without using the open button.
- **ALERTS/FLAGS ARE TEMPORARY NOTES, LIKE A PERSONAL MESSAGE OR A POST-IT NOTE. THEY DO NOT GET FILED IN THE PATIENTS MEDICAL RECORD AS A DOCUMENT WITHOUT BEING CONVERTED.**
Documents Tab from Desktop

- Documents tab lists all documents on provider/staff desktop for action, review, or signature.
- **View documents to:** allows user to view other staff member’s documents. Enter the users name or click the drop down menu to select from the View documents to box.
- The box showing document types allows a person to view all of a certain type of document (i.e. Lab Reports, Phone Notes, etc.) by clicking on that document type.
- The buttons allow various functions to occur. Like open, Route, Remove, etc.
- The comments box allows for a message to be sent with a document. It is a “throw away” field. It will not go to the chart and will only appear on the Documents Tab.
- The details area explains more about the flag being viewed. Date, Time, who the document is from, etc.
- The bottom area allows the Document to be read without using the open button.
- DOCUMENTS ARE A PERMANENT PART OF THE PATIENTS CHART.
Sending a Flag
Flags (cont’d)

Create a New Flag

1. Click the Flag icon.
2. Select the user(s) to whom you are sending the flag.
3. Select the Priority – default is NORMAL.
4. Select the Start Date – default is TODAY. To send a flag in the future as a reminder, select a due date in the future.
5. Attach the flag to:
   - Patient’s Chart
   - Patient’s Registration
   - Appointments
   - Recipient’s Desktop
6. If the flag is attached to a patient’s chart, the “Subject” will default to the patient name. If attached to the Recipient’s Desktop, the “Subject” will be blank. Enter a subject as needed.
7. Type your message in text box
8. Select appropriate action button:
   - Click to send the Flag.
   - Click to put the Flag on your desktop to be completed later. It will be in italics.
   - Click to discard the Flag.

Reply to a Flag

12. From your Desktop or a patient’s chart, select the flag to which you wish to reply.
13. Click
14. Verify that the user to whom you are sending the reply is correct. Modify if necessary.
15. Verify that properties are correct.
16. Type your reply at the top of the message box.
17. Select the appropriate action button as above (Sending a Flag).
Flags (cont’d)

Forward a Flag

18 From your Desktop or a patient’s chart, select the flag to which you wish to forward.

19 Click.

20 Select the user to whom you are forwarding the flag.

21 Verify the properties are correct.

22 Type your message.

23 Select the appropriate action button as above.

Remove a Flag

24 Select the flag you wish to remove.

- Control-click will allow selection of multiple flags.

25 Click.

If you a user removes a flag in error, the user can retrieve the removed flag. However, the flag will only display on the desktop for 30 days from the day it was removed. All removed flags will be highlighted in gray.

26 Click on the Alerts/Flags tab.

27 Click on the Organize button.

28 Click the check box “Viewed removed alerts/flags” and click OK.
Converting an Alert/Flag to a Document

1. From the Desktop, highlight the Flag and review.
2. Click on the button.
3. If the patient has not been attached, find the patient now.
4. Use the drop down menu to select the appropriate document type: Phone Note, Rx Refill, External Correspondence, or Internal Other.
5. Use the drop down menu to change the provider as needed.
6. Type in a summary.
7. Choose an action:
   8. Click to convert the flag and sign the document.
   9. Click to convert the flag and put the document on hold on the desktop of the provider for the document.
10. Click to go to the update in the patient’s chart. Phone Note, it will open the Phone Note form; Rx Refill will open the Refill form; External Correspondence and Internal Other will open updates with the text of the flag but no form. Edit the form/update as needed and [End Update]
11. Click to go back to the flag but do not convert it to a document.
Finding a Patient Chart

From the Centricity Desktop click on the Chart button.

NOTE: If you have previously reviewed a patient chart during this session the last patient chart review will appear automatically. If this occurs click the button from the chart.

Ctrl + F will also bring up the find patient dialogue box from either the desktop or the patient chart.

These methods will bring up the find patient dialogue box below.

1. In the Search for: text box type the **first three letters of the last name and the first two letter of the first name** of the patient that you are searching for separating them with a comma and then click search. If you don’t know the patients first name type as much of the last name as you know.

2. Search criteria can also include DOB, SS#, Athena Net account number, etc.

3. Choose the appropriate patient from the search results list, verifying the demographic information that you have available and then click the OK button.

*Hint*: To avoid duplicating a patient, using the partial name look is the best way to look up a patient. You can also use the patient’s Medical Record # to search for a patient.

You can open a patient chart from the appointment list from the desktop. Click the desired patient from the appointment list to open the chart.

The drop down menu next to the Chart icon will allow you to see the last 10 patient’s chart that was open. You can click on any of the last patient’s displayed on the list to reopen the chart.

Logging Out of Centricity EMR

To log out of the Centricity Electronic Medical Record (EMR) click the **EXIT** button on the toolbar in the upper right hand corner of the application.
Completing the Phone Note & Routing a Document
Completing the Phone Note & Routing a Document

Take a call or pick up voice mail and start a Phone Note

1. Click on the ☑ icon.
2. Fill in appropriate information in the form, including “Reason for Call”.
   - NOTE- if a Reason for Call check box does not apply, the user can free text a Reason for call in message box below the Reason for Call.
   - NOTE- the user can select a check box for what number is the best way to be reached. The phone numbers pull over from the patient registration.
3. Click .
4. Click .
5. Enter a Summary always
6. If the phone note is complete, click on then click Sign Document to finish. If the call is not finished, go on to step 7.

As needed, route to appropriate staff

7. If the call needs attention from another staff member, change the provider to whom you need to route this document by selecting the New... button, then selecting the appropriate provider.
8. To write a comment or change the status from “Normal” to “Important” or “Urgent”, click the drop menu at the Priority prompt.
9. Click OK.
10. Click to put the document on hold and route to appropriate provider’s desktop.

Review the Phone Notes routed to your desktop

11. Throughout the day, review your desktop for Phone Notes that require your action.
12. Highlight a document and click Open or double click to go to the update on hold.
13. Review the note.
14. If needed, review the patient’s chart.
15. Type your instructions or record your actions on the phone note
16. Click .
17. If the phone note is complete, click on then click Sign Document to finish. If not and you wish to route it back to your staff for follow-up phone call to patient, go on to step 18.
Completing the Phone Note & Routing a Document (cont’d)

Route as needed

18 To Route click on **New...** to create a different Routing Slip. (If you are routing back to the original person who sent the phone note to you, their name should already be in the “Route To” section.

19 Click **OK** on the New Routing Information window then click **Sign Document**.

**NOTE:** When entering a comment in the Comment display box, the comment will not route with the note or document.

Completed phone call to patient

20 Throughout the day, review your desktop for Phone Notes that require your action.
21 Highlight the phone note for which you are going to take action.
22 Click the **Append** button.
23 Type narrative regarding your conversation with the patient.
24 Click **Sign**.
25 Process is complete.
Working with Quick Text

1. Start a chart update.
2. Do not select an encounter type.
3. Go to Options>Quick Text (menu at top of screen).
4. Click the radio button for Personal User if it did not default.
5. In the “Replace” box, type a period followed by selected characters.
6. In the “With” box, type your text as you would want it to appear in a chart note.
7. Click Add and then Close.
8. On your chart note, type a period followed by selected characters (case sensitive) and press Enter.

The text you entered will display on the chart when the selected characters are typed followed by a period and the Enter key is pressed.
Managing Documents

1. From the Desktop, select a document and click **Open** to open the patient’s chart and open the document.

2. Depending on the type of document you selected and what privileges you have you may have the following options:

   - **Sign**
   - **Append**
   - **Route**
   - **Remove**

   with chart update bar.

3. To view documents by type, select the document type from the list on the left.

4. Press the **Organize** button to change your document view preferences and press OK to accept changes.

5. You can also organize the patient’s chart by the contents of each column by clicking in the column header.

6. A **pen** indicates the document lacks a signature. A paperclip indicates the document has attachments (like an EKG tape or mammogram).
Viewing Summary Tab

1. Summary tab is the equivalent to a summary page in paper chart.

2. On the Summary tab the user can view: Problems, Medications, Flowsheet, Documents, Allergies, Directives, Care Alerts, and Registration Notes.

NOTE: if any of the above is selected on the Summary tab, the system will automatically direct you to that specific tab.

- Problems
- Medications
- Flowsheet
- Documents

If Allergies is selected, the system will direct you to the Alerts/Flags tab.
Viewing History Tab

History Tab

1. Viewing histories will allow the user to view the patient’s Past:
   - Medical History
   - Surgical History
   - Social History
   - Family History

2. You can set an attached view for that specific patient by selecting the desired view from the drop down list and then clicking the Set Attached View button.

3. You can set a preferred view for all your patients in preferences.
Viewing Problems Tab

1. Viewing problems – click Active Only radio button to view current problems.

2. Click – All to view history of problems.


4. By double clicking on a specific problem, you can review the chart note in which the problem was entered.

Users can view the Medscape Problem website, if necessary.

- At the "Lookup problems with:" prompt, click the drop down menu to select Medscape Problem Search.
- Click the Web Lookup to access the website.
Viewing Medications Tab

1. Viewing medications – click **Active Only** radio button to view current problems.

2. Click – **All** to view history of medications.

3. **Gray items** – indicate removed medications.

4. By double clicking on a specific medication, you can review the chart note in which the medication was entered.

Users can view the Drugs Online, if necessary.

- **At the “Lookup medications with:” prompt, click the drop down menu and select from the list.**

- **Click the Web Lookup** to access the website selected.
Viewing Alerts/Flags Tab
(Allergies, Care Alerts/Flags, & Directives)

Viewing alerts may appear as a pop-up, you can Read them, Note them. Close the pop-up to continue.

Viewing Alerts/Flags Tab (Allergies, Care Alerts/Flags, & Directives)

1. Viewing Allergies & Directives – click Active Only radio button to view current items.

2. Click – All to view history allergies and directives.

3. Viewing Care Alerts & Flags – click Today or Anytime radio button to view respective items.

4. Click the “Organize” button and click “view all” to see Alerts/flags to other users.

5. Gray items – indicate removed items.

6. Drug Interaction button will bring up any interactions with allergies and medications.
Viewing Alerts/Flags  
(Allergies, Care Alerts/Flags, & Directives) (cont’d)

From the Alerts/Flags tab in the patient’s chart, users can create care alerts and pop-up messages. These messages will display in the patient’s chart. However, they are not a legal document within the chart.

Creating Care Alerts and Pop-ups
1. From the patient’s chart, click the [New] Flag icon.
2. Choose the Care Alert or Pop-up radio button in the Properties box.
3. In the Message Box type your Care Alert Message or Pop-up message.
4. Click Send.

The user can disable a pop-up message. If the pop-up message is disabled, that users profile will not see any pop-up messages for all patient charts. If disabled, the user can re-enable the pop up message to display.

Disable Pop-up Message
1. To disable the pop-up message, click the check box next to “Disable popups care alerts” from the pop-up message window.

Re-enable Pop-up Message
2. Go to Options>Display.
3. Click the Check Box “Restore warning message dialogs” and click OK.
4. In the patient’s chart, click on the Alerts/Flags tab.
5. Click the button.
6. Under View, remove the check mark from “Do not show pop up for care alerts” and click OK.

NOTE- in order for the pop-up message to display, the user will need to access another chart, then go back to the chart with the message, to see it display.
Viewing Flowsheet Tab

1. While in a chart, click on the Flowsheet tab.
2. Choose the flowsheet you wish to view by entering the name of the flowsheet or by clicking the drop down menu. To set the attached view, select the flowsheet that you want to attach to this patient and click on the Set attached View button.
3. You can also view values within a date range by completing the date fields.
4. To view more details about a result, single click on the observation. The details will appear in the area below the grid.
5. To see the document related to an observation value, double click on the value.
6. Review the document. Click Close when finished.

NOTE-
- The Flowsheet is only used for viewing. To make changes, the user would have to open an office visit or clinical list update.
- Blue represents values that have been interfaced. Black represents values that have been manually entered.
Viewing Orders Tab

From the Orders tab, a user can do the following:

1. While in a patient’s chart, click the Orders tab to view the status of a patient’s orders. The status of an order may be one of the following:
   a. Admin Hold – Orders requiring preauthorization.
   b. In Process – Orders that are awaiting results.
   c. Complete – Orders for which results have been received and recorded.
   d. Cancelled – Orders that have been cancelled.

2. Click an order to view the details for that order.
   There are three order types:
   a. Test – Ex. Radiology, Labs
   b. Service – Ex. Office Visit, Med Admin
   c. Referral – Ex. Specialty Consultation

3. Reprint an existing order:
   1. Highlight the order and click the print button on the main toolbar.
   2. Under “Printed Items” verify Selected Order(s) is highlighted
   3. Under Tests and Referrals, verify Provider Form checkbox is the only box checked.
   4. User may click preview button to review before clicking the print button.
**Viewing Documents Tab**

1. To sort documents in list – Click on any **heading**. Click on date and time heading and it will sort in ascending order – click on it a second time it will sort in descending order.

2. To view an attachment, click to highlight the desired document (a paper clip image will appear next to the document), click the **Attach** button and select **External Document** doc.

3. Click on Summary heading all summaries will be sorted in alphabetical order, etc.

4. Document View is defaulted to ALL. Click on the **All** folder and select specific type for sorting by document type. The user can also view a specific document type by clicking the folder for that document type. For instance, if a user only wants to view office visits, the user would click the **Office Visit** folder to display all office visits.
MENU BAR
Registration

To View Registration area of chart click the Registration button 😇.

If you are currently on the patient’s chart, this will open the registration module, as viewed below for that specific patient:

Registrations contains patient registration information from the Centricity Business side. The tabs include:

- Patient Information – patient address, SS#, DOB, race, ethnicity
- Insurance Information – Insurance information from PM
- Contacts Information – Pharmacy, physician, etc.
- Appointments- previous and current appointment information
- Financial
- Registry—Can opt patient in or out of immunization registry. Click the button to close this screen and return to the chart.

Registration is where you mark a chart as sensitive.

- Click on the button.
- Click the check box next to Sensitive Patient.
- Click OK.
Graphs

Graphs allow for patient information to be viewed from the chart. The flowsheet must be set as the attached view in the patient’s chart for this to work.

Click the graph button within the chart. This will open the graph observations screen. Select the items you wish to graph, and click show graph.

Please Note:

- Growth charts are available.
- The flowsheet view dictates the options available for graphing. Be sure to have the view on the flowsheet set to ALL in order to have all graphing options available.

Graph will appear:
Handouts

Centricity EMR contains Exit Care Clinical Handouts. To review available handouts click the Handout button. This will open the “Patient Handout” screen. This allows for each module, physician, etc. to have a custom list. If a custom list is not available click the binoculars to review available handouts.

This will open the Find Handout screen. There are two tabs associated with this screen. Browse & Search. Browse allows you to look thru the categories listed. Once you have selected the appropriate handout, verify the “Record handout printing in Chart” box is checked, then click the “Print” button.

Search allows for a search to be made by topic. Be sure to click the check box at the “Record handout printint in chart” if you need to track in the chart.
Saving Items in “My Folder”

1. Press \(\text{New}\) to start a new flag.
2. Press \(\text{Find}\) to find users.
3. Press \(\text{Expand}\) to expand the screen.
4. Choose a name from the list and press \(\text{Add Item}\).
5. To search for a name, press the Search tab and enter the first few letters of the last name and press the Search button.
6. To group names within your folder, press \(\text{New Group}\) and name your new group.
7. To select which names appear in your drop down list, select a radio button or select a folder and press \(\text{Set}\).
8. Press OK when finished.
PATIENT CHART
Rooming/Opening an Office Visit

1. Log onto Centricity EMR.
2. From the Summary tab on your desktop or by clicking Appts, view the physician’s schedule for today’s patient appointments.
3. When a patient is marked as arrived, a “black dot” will appear to the left of the patient’s name on the schedule (this is the indicator that patient is ready to be roomed).
4. Escort patient to available exam room.
5. From the appointment schedule, highlight the patient’s name that you are in the room with (yellow box will appear around patient’s appointment).
6. Click the Open Chart button to open the patient’s chart.
Rooming/Opening an Office Visit (MA/LPN)

1. While in a patient’s chart, click the “Update” button.
2. Select an Encounter Type.
3. If this is an office visit that is a *Transition of Care – In*, check the box labelled “*Encounter is a Transition of Care*”.
4. In the field labelled “*Provider*”, verify the field is populated with the name of the responsible provider.
5. Click the button to select a visit ID.

6. The “*Select Visit ID*” pop-up will appear. Select the appropriate Visit ID and click “OK”.

7. Click “OK” again when returned to the Update Chart pop-up.
Transition of Care – IN

Reconciliation of Problems, Medications, and Allergies

Transfer of Care IN occurs when a patient’s care has been transferred into your practice from another setting, or referred to your practice.

When beginning a NEW ENCOUNTER, be sure to check the box labelled “Encounter is a Transition of Care”. This denotes that the patient is being TRANSFERRED IN for the purpose of this office visit. The user will then click OK which brings them to the HPI-CCC form.

Please Note: Clicking the Reconciliation button from one of the following forms will launch the Reconciliation HTML form:

- HPI-CCC
- Problems-CCC
- CPOE A&P-CCC
- MU CORE Checklist
Transition of Care – IN (cont’d)

Please Note: If a CCDA document has been imported and has NOT YET been used to reconcile clinical list information, then that document will appear at the top of the screen as a choice for DOCUMENT TO RECONCILE.

***CAUTION: The “Mark Reviewed” button will remove the CCDA from being available for any other reconciliation. (Including if the current document is discarded without signature)***

1. Select the document you wish to reconcile in the “Document to Reconcile” field. The form defaults to the Problems tab, which is where the user should begin.

2. The Imported problems will be listed on the left. Mark the desired problem with a check mark to add to the patients chart, then click “Add To List” button.

3. The Active Patient Problem List, which appears on the right, may be edited as well. To do so, the user can click the box of the desired problem, then click the edit or remove buttons.
Transition of Care – IN (cont’d)

4. Click on the “Allergies” tab to reconcile allergies and the “Medications” tab to reconcile medications using the same steps as above.

5. Once completed with the exchange, the user can click the “Mark Reviewed” button.

**Please Note:** The “Mark Reviewed” button IS NOT about reviewing the clinical list, but rather about reviewing the CCDA. Once this button is clicked, it CANNOT be undone, and that CCDA will no longer be available for use in reconciliation.

6. If no CCDA documentation is received and available, this workflow will not apply to the patient’s visit.
Rooming/Opening an Office Visit (Provider)

Review clinical data collected by nursing staff
1. In the exam room, log into Centricity EMR.
2. From the documents tab in the chart, double-click on the on-hold document for today’s visit.
3. Review the information entered by the clinical staff.
   NOTE: When entering the Vital Signs, the user can click button to default the name of the user entering the Vitals.

Complete your note
4. Complete the HPI form and fields on form, if needed
   Note- Users can access the miscellaneous forms from the HPI screen.
6. Physical Exam form, CPOE-A&E form, if needed
7. Complete Patient Instructions form, if needed
8. Assign new Problems and Assess existing Problems, if needed.

Update the Clinical Lists, Problems, Medications, Allergies, and Directives
9. Add new or adjust existing medications, if needed
10. Update Allergies & Directives, if needed.

   Sign the Document
11. Click .
12. Update the summary if needed.
13. If the document is complete, click Sign Document.
14. If the document is not yet complete:
   • Make sure the “Sign clinical list changes” is checked.
   • Click Hold Document.

Exit from Centricity
15. Click on the red & white on the tool bar to exit to the Centricity EMR login screen.

All charts must be signed before the charge can be entered into the Centricity Business system. This will be critical when we begin utilizing the charge batch interface.
Capturing Family History in FH/SH-CCC

1. Select the relationship for which the user would like to record family history, and Refresh the page. (If patient is not updating FH check the box labeled No Known Family History or No Known Relative)

2. Check the desired boxes to indicate family history.

3. Enter a Comment if desired. Then click Save. **Please Note:** Comments will apply to all checked items when saved. To enter a different comment per item, check the individual box and save one at a time.

4. Repeat for additional relationships as needed.

5. To modify or Remove a previously stored Family History item for an individual relationship, choose the Relationship (if not already selected) and Refresh, as done in Step 1, then choose the Item to modify or remove:
Capturing Family History in FH-SH/CCC (cont’d)

6. To modify comments, make the changes in the Comment field, then click the Save Updates button. To remove an item, choose a removal reason then click the Remove button.

7. Saved Family History items will display in the Family Hx Summary area. To indicate that Family History has been reviewed during the visit, check the reviewed – no changes required box.

8. Once Family History has been recorded, user can now record smoking status.
Capturing Smoking Status in Social History in FH-SH-CCC

1. To capture Smoking Status, select the appropriate radio button. If “Current” is selected, choose a specific option from the additional drop-down list.

Please Note: The reference button is available to assist with selecting the most accurate description of the patient’s smoking habits. Clicking the “Ref” button will display a pop-up describing each status in detail. The “Ref” button will only appear when the “current” radio button is selected.

References:
Capturing Smoking Status in Social History in FH-SH-CCC (cont’d)

2. If appropriate, record “Counseled to Quit” by selecting an option from the drop-down list.

3. Record alcohol use with the appropriate check box. If Social History was completed prior to the visit and no changes are to be made, click the reviewed – no changes required checkbox. Once completed, click the Insert Selected Values button to add to the Social History template. Social History will appear in the edit field.

Please Note: Values entered in the FH-SH-CCC form to record smoking and alcohol use will populate in the risk factors form. However to record if a smoker smokes cigarettes, cigars or pipes, the user must enter this data on the risk factors form as this data can only be collected in the risk factors form.
Immunization Management

1. Open the Immunization Management form.

2. Make selection from Customs List drop-down.

(Please Note: Refer to icon list on the Immunization Management page)

3. If the provider wishes to administer a vaccine, he/she can do so by clicking one of the icons on the overview tab corresponding to the vaccine desired. This will bring up the Administer DTaP window shown below.
Immunization Management (cont’d)

4. Complete the following fields as per your practice workflow.
   
   **(Please Note: all may not be required.)**
   
   a. Manufacturer
   b. Lot #
   c. Expiration Date
   d. Site
   e. Route
   f. Units
   g. Administered by
   h. Date
   i. Time

5. Click Done.

   **Please Note:** The Manage Lots button enables the user to add a Lot # to a specific manufacturer. Doing so enables the Lot # and Expiration date to auto populate when that manufacturer is selected. The user is able to manage lots by following the steps below:

   1. Click the “Manage Lots” button in the Administer DTaP window. The Lot Management for Daptacel Intramuscular Suspension window will appear.
Immunization Management (cont’d)

2. Select a manufacturer from the drop-down list.
3. Enter the Lot #.
4. Enter the Expiry Date.

5. Click the “Add” button to add the entry to the Available Lots list and click “Save & Close”.

Please Note: The Available Lots can be edited or deleted by clicking the corresponding buttons for that lot.
Immunization Management (cont’d)

If the vaccine was NOT administered, select Not Given, the reason and click done.
### Immunization Management (cont’d)

#### Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Green Checkmark" /></td>
<td>Immunization given, but not in this clinic. Details of administration may be incomplete. Hover to see available details. Click to see available options.</td>
</tr>
<tr>
<td><img src="image" alt="Green Checkmark" /></td>
<td>Immunization given in this clinic. Hover to see available details. Click to see available options.</td>
</tr>
<tr>
<td><img src="image" alt="Green Checkmark" /></td>
<td>Combo Immunization given in this clinic. Hover to see available details. Click to see available options.</td>
</tr>
<tr>
<td><img src="image" alt="Exclamation Mark" /></td>
<td>Immunization NOT given in this clinic for a specific reason. Hover to see available details. Click to see available options.</td>
</tr>
<tr>
<td><img src="image" alt="Question Mark" /></td>
<td>Immunization may be due – based upon available scheduling information, patient’s age and immunization history. The Physician is expected to evaluate and make the judgement to give or not give today. Hover to see available information and click to see options.</td>
</tr>
<tr>
<td><img src="image" alt="Green Plus Sign" /></td>
<td>Give this immunization today. The physician has chosen to give this immunization today and it has not yet been administered. Hover to see available information, click to administer now and click ✗ to cancel the request.</td>
</tr>
<tr>
<td><img src="image" alt="Green Checkmark" /></td>
<td>Click this icon to give now or give today. A prompt will allow selection to give now (open the Administration pop up), give today (add the Immunization Class to the ‘Administer[ed] Today’ list, or Cancel. This icon will appear on the grid row for any Immunization Class that does not already present a ‘may be due’ icon.</td>
</tr>
<tr>
<td><img src="image" alt="Red Dot" /></td>
<td>The red dot symbol may appear with any immunization icon to represent that an Adverse Reaction was noted. Hover to view details. Click to see available options.</td>
</tr>
</tbody>
</table>
Medication Administration

The Medication Administration Form is a form that will allow the provider to request a medication to be administered during the office visit. This will allow for another clinical support staff (CMA/LPN) to document the medication that was administered. The information that is documented, will automatically update within the Orders form.

1. On the HPI form within an office visit, click the Medication Administration check box.

   Please Note: The user will be directed to the Medication Administration form.
Medication Administration (cont’d)

2. On the Medication Administration form, click the “New” button.

Please Note: The system will automatically move to the Add/Update Request tab.

2. At the “Meds Custom List” prompt, click the drop down menu and select from the list.

3. At the “Select Medication” prompt, click the drop down menu and select the desired medication.

4. At the “Primary Diagnosis” prompt, click the drop down menu and select the diagnosis that is linked to the patient’s problem’s list.

Please Note: If the diagnosis is not there, click the Problems button to add a new problem.

5. At the “Requested By” prompt, click the “<Me” button to enter your name.

6. At the “Start Date” prompt, enter a date or click the ”<Today” button.
Medication Administration (cont’d)

7. At the “Stop Date” prompt, enter a stop date or click the “<Today, 1mo, 2mo, 3mo, or 1 yr.” buttons.

   **Please Note:** The Instructions and Comments sections are not required, but the user can enter information in those sections by using free text.

8. Click the “Commit Request” button.

   **Please Note:** The system will automatically go back to the Administration Meds Summary tab.

9. Click the “Administer” button.

   **Please Note:** The system will automatically move to the Administer Medication tab.
Medication Administration (cont’d)

10. At the “Administered By” prompt, enter the person who will be administering the medication or click the “<Me” button.

11. At the “Route” prompt, click the drop down menu to select a route.

12. At the “Site” prompt, click the drop down menu to select a site.

13. At the “Mfg.” prompt, click the drop down to select a manufacture.

14. At the “Lot Number” prompt, click the drop down menu to select a lot number.
   
   **Please Note:** To create Lot Numbers, users will have to click the Manage Lots button to add a number.

15. At the “Amount Given” prompt, click the drop down menu or type the amount that should be given.

16. At the “Units” prompt, click the drop down menu click to select a unit.
   
   **Please Note:** The NDC prompt does not need to be completed.

17. Click the “START” button or enter a start time.

18. Click the “STOP” button or enter a stop time.

19. Click the check box labelled “Auto Generate Orders” to order the medication.

20. Click the “Commit Administration” button when everything is completed.
   
   **Please Note:** All fields that have an asterisk (*) are required fields. The user will be unable to commit the administration until all fields are complete.
Medication Administration (cont’d)

*Please Note:* The system will move to the Medication Administration Orders form.

21. At the “Select Procedure” prompt, click the drop down menu to select a procedure.

*Please Note:* The Associated Problems and Units will default and the Comments section is not required.

22. Click the “Order” button. The user will be directed back to the “Medication Administration” form.

23. To close the form and return to the office visit, click the “X” in the top right corner of the form.

24. Click the “Close” button to remove the “Medication Administration” window.
Using Clinical Decision Support

1. Open the CPOE A&P-CCC form.

2. Select a problem from the Problems List drop-down.

(Please Note: CDS is programmed for only Diabetes Mellitus and Myocardial Infarction at this time.)

3. If the patient is missing a particular medication associated with the chosen problem then a CDS prompt will appear like the one shown below. CDS references are required to be present. If the clinician desires to see it, they would click “Yes”.

The patient has diabetes and is currently not on an ACE-I or ARB. If the patient has coexisting hypertension or renal disease, consider starting an ACE-I or ARB as long as there are no contraindications. Caution: ACE inhibitors and ARBs are contraindicated during pregnancy. For female patients, check pregnancy status of the patient before prescribing ACE/ARBs.

Would you like to view the CDS references for this condition?

Yes  No
Using Clinical Decision Support (cont’d)

4. After clicking “Yes”, the clinician will see the pop-up below and click “OK”.

5. After referencing, clinicians will be prompted to add a medication or to say “No” if there is any reason for contraindication.

6. If they chose “No” a yellow button will appear to document the contraindication using the CDS Contraindications-CCC form.
Using Clinical Decision Support (cont’d)

7. Fill in the appropriate treatment, reason for contraindication, and click “Commit to Flowsheet”.

Please Note: This will prevent this particular CDS prompt from occurring again in the future for this particular patient only.

8. If the clinician would like to follow the advice of the CDS prompt they’d just click “Yes” and this will open up the Update Medications window. Refer to Medications under Clinical List Changes.

9. In future office visits, as long as the patient has an active medication that meets the CDS criteria or a contraindication that has been noted then the CDS prompt will not appear again.
Patient Instructions CCC
Producing a Clinical Visit Summary (CVS)

The PATIENT INSTRUCTIONS HANDBOOK can no longer be used in 2014 to count toward MU measure. The new Generate CVS button should be used in lieu of the Print Patient Instruction button.

( Please Note: Stage 2 requirement changed to provide patient clinical visit summary within 1 business day.)

In order to generate a Clinical Visit Summary, the EP must click the Generate CVS button within the Patient Instructions CCC or the MU Visit Check List form as shown on the following pages.
Patient Instructions CCC
Producing a Clinical Visit Summary (CVS) (Cont’d)

The CVS window will open and the EP will have the option to:

- **Print:** Allows user to print the CVS and provide a copy to the patient.
- **Save To Chart & Close:** Allows user to save the CVS to the patient’s chart.
- **Save To File:** Allows user to export CVS to Patient Portal. See Patient Portal section for details.

The user also has the option to customize the Clinical Visit Summary by clicking the “Customize” button.
Patient Instructions CCC
Producing a Clinical Visit Summary (CVS) (Cont’d)

Clicking the “customize” button gives the user the option to:

- **Customize Sections & Entries:** Allows the user to select which of the items stored under this subheading will appear on the CVS by placing a check in the corresponding box.

- **Include/Exclude Sections:** Allows the user to exclude any item listed under this subheading by removing the check mark from the corresponding box.

Once the desired changes have been made, the user must:

1. Print the CVS by clicking the “Print” button.
2. Click the “Save to Chart & Close” button.

As previously stated, this measure can also be met by clicking the Generate CVS button at the close of the office visit on the MU Visit Checklist. Should a patient decline the CVS, it should be recorded on this form by clicking the Patient Declined CVS check box.
MU Core Checklist

The MU Core Checklist form is used as a tool for EP’s to verify that they have met all required measures for the office visit. Items marked missing or have a red “X” will require additional information in order to meet the corresponding MU measure. Items marked done or with a green checkmark require no further action.

Should the chart require additional information, the EP may do so by:
1. Clicking the corresponding button which will direct them to the form of which the measure was missed.
2. Check the corresponding boxes.
3. Select appropriate radio button.
4. Enter Vital Signs directly to form.
5. Click Generate CVS button for the Clinical Visit Summary.
6. Print handouts.

(Please Note: Demographic information can only be captured in Centricity Business IDX.)
Discarding a Document

If a document was started in error and the user wanted to cancel the document, the user could Discard the Document so it does not become a legal document within the patient’s chart. This applies for Office Visits, Clinical List Updates, Phone Notes, etc.

1. After a document has been started, click the End Update button.
2. On the End Update window, click Discard Document button.
3. At the OK to discard document message, click OK.

(Please Note: Discarded documents can be tracked.)
Physician Coverage

Physician Coverage

1. From the Documents tab in the Desktop, change the “View Documents To” to see documents for appropriate provider.

2. If provider is not seen, click \( \text{Find Provider} \) to find provider.

3. Highlight a document and review.

4. If the document needs attention from someone other than yourself, click on \( \text{Send Document} \) and send it to them with comments and priority as needed.

5. If the document requires action from you, click \( \text{Sign} \).

6. Enter comments by typing or use Quick Text.

7. Click \( \text{Sign} \) to sign the appended note and the original document, however, the document will remain on the responsible provider’s desktop.

8. Click \( \text{OK} \).

9. Click \( \text{Sign} \).
Managing Medications
Managing Medications (cont’d)

1. Click on the [Meds] button.
2. Click on the [New...] button.
3. At the **Custom List:** enter your department or click the drop down menu to select a department.
4. Type the first few letters of the medication in the box below the **Custom List:** or choose the medication from the reference [Reference List...] button.
5. If medication does not display in the box click on the [Reference List...] button.
   - Type the first three letters of the medication in the **Search For** box
   - Click the [Search] button.
   - Highlight the medication you are searching for then click the [OK] button.
6. The chosen medication will appear in the Define Medication section of the form.
   **Please Note:** If the medication prescribed is uncoded, the user must select category type as drug in order to meet Meaningful Use requirements.
7. Type patient **Instructions** in the Instructions box.
8. Type patient **Comments** in the Comment box, if necessary.
9. Type **Start Date** or click the drop down menu to select a date
10. Type **Stop Date** only add a stop date if it is a medication which is for an acute illness. Chronic illnesses do not put a stop date.
    **Please Note:** If a stop date is entered, the duration will duration will auto populate.
11. Type **Duration** in the Duration box.
12. Select one of the radio buttons for **Day, Weeks or Months.**
13. Click on the **Dosing Calculator** if assistance is needed to determine medication dose
    - Dosing page will display, the data on the page calculates the patient’s height, weight and age. Click on the [Close] button to return to the medication page
14. Type **Quantity.**
15. Type **Refills**, if no refills are permitted type a “0” in the **Refill** box
16. Click on the **Brand Medically Necessary** box if the patient can only receive a brand name medication.
17. Click on the **Print Pt. Handout** box if you desire to provide a patient handout material regarding the specified mediation prescribed.
   - Click on the [Select] button to choose a pharmacy other than the one that displays in the **Pharmacy** window.
   - Click the **Mail Order, Retail or All** radio button to select a view.
   - In the Select Pharmacy box, type the name of the pharmacy you are looking for.
Managing Medications (cont’d)

- Click on the **Search** button.
- Click on a Pharmacy from the drop down list or click on the **New...** button to add a pharmacy.
  - Complete all of the fields on the **New Pharmacy** screen.
  - Click **OK** button to complete the process for adding the new pharmacy.
  - If this is the pharmacy in which the patient will always be going to, don’t forget to click on the **Add this pharmacy to the patient’s contact list.**
- Review the data in the **Detail** box.
- Click **OK** to complete the process for pharmacy search.

18 **Authorized By** field will default, accept the default or search for a provider by clicking on the **#**.
- Click on **Search** tab.
- Click on **Search In** appropriate folder to begin your search.
- Type first few letters of the provider’s last name in the **Search** box.
- Select appropriate provider from **Search Result For** drop down.
- Click **OK**.

19 The **Prescribing Method** will default **Electronic**.

**Please Note:**
- **Narcotics will have to be prescribed by a handwritten script.**
- **A user may also select Pending Approval. This option allows an EP to review, as well as, print/send prescriptions entered by a non-EP.**

20 Choose **State** from drop down. The state will always default to state the patient resides.

21 **Type Note to Pharmacy** if applicable.

22 Click on the **Qty Refills** box, this process will automatically click the Add to Custom List, Drug, and Instructions/Duration.

23 Click **OK** to complete the process or click **Save & Continue** to add another new medication.

24 End Process.
RX Refill

Take call (or pick up message or fax) and find the patient’s chart

1. Find patient chart in Centricity EMR.
2. Review the refill request and the patient’s Centricity EMR chart.

   Document the refill (phone call or voicemail from patient or pharmacy)

3. Click on the Icon.
4. Document the reason for the call on the “Phone Note” tab.
5. Click on the “Follow-up” tab
6. Click on the “Rx Refill” button.
7. Complete as much of the refill form as possible.
8. Click the button to enter the patient’s Pharmacy information.
   - Click on the button to choose a pharmacy other than the one that displays in the Pharmacy window.
RX Refill (cont’d)

- Click on **Mail Order, Retail or All** radio button.
- In the **Select Pharmacy** box, type the name of the pharmacy you are looking for.
- Click on the **Search** button.
- Click on a Pharmacy from the drop down list or click on the **New** button to add a pharmacy.
  - Complete all of the fields on the **New Pharmacy** screen.
  - Click **OK** button to complete the process for adding the new pharmacy.
  - If this is the pharmacy in which the patient will always be going to, don’t forget to click on the **Add this pharmacy to the patient’s contact list.**
- Review the data in the in the **Detail** box.
- Click **OK** to complete the process for pharmacy search.

9 **Authorized By** field will default, accept the default or search for a provider by clicking on the **Authorize**.
- Click on the **Search** tab.
- Click on **Search In** appropriate folder to begin your search.
- Type first few letters of the provider’s last name in the **Search** box.
- Select appropriate provider from **Search Result For** drop down.
- Click **OK**.

10 The **Prescribing Method** will default **Electronic**. Narcotics will have to be prescribed by a handwritten script.

11 Choose **State** from drop down. The state will always default to state the patient resides.

12 Click **Close**.

13 If there is more information for provider, type it above the script information in the **Update text**.

14 Click **End Update**.

15 Leave the summary blank.

16 Change the provider to the provider who will be authorizing the refill.

17 Verify that the provider’s name appears in the “Route to” box.

18 Click **Hold Document**.
RX Refill (cont’d)

Document the refill (fax from Pharmacy)

19 Click on the icon.
20 Complete as much of the refill form as possible.
21 Click Close.
22 If there is more information for the provider, type it above the script information in the Update text.
23 Click End Update.
24 Leave the summary blank.
25 Change the provider to the provider who will be authorizing the refill.
26 Verify that the provider’s name appears in the “Route to” box.
27 Click Hold Document.

Review refill requests and send instructions to clinical staff.

28 Throughout the day, review your desktop for refill requests.
29 Highlight the document and click Open.
30 Review the chart as needed.
31 If the refill is not authorized:
32 Open the Refill form, uncheck the refill(s) and click Close.
RX Refill (eScriptMessenger) Approved

1. From your desktop, open the refill request document.
2. Click the button.
3. Click the button.
4. Select the *eSM RX Refill* encounter type from the Append Document window and click OK.
5. Verify the refill medication is from the patient’s medication list. If not, click the drop down menu to manually search for the correct medication from Medication: prompt.
6. Click the Approved radio button.
7. Verify the instructions listed on the Refill Response side match the instructions from the Refill Request from Pharmacy side.
8. Click the button and then click the Close button.
9. Click .
10. Enter a summary at the Summary: prompt.
11. Click the Sign Document button.
RX Refill (eScriptMessenger) Denied

1. From your desktop, open the refill request document.
2. Click the button.
3. Click the button.
4. Select the *eSM RX Refill* encounter type from the Append Document window and click **OK**.
5. Click the Denied radio button.
6. Select a reason for the denial by clicking the appropriate radio button.
   
   **NOTE:** If the reason for the denial is not listed, the user can type the reason why the refill is being denied in the Other Denial Reason: prompt.
7. Click the button.
8. Click **End Update**.
9. Click the **Sign Document** button.
RX Refill (eScriptMessenger) Deny Request & Send a New Prescription

1. From your desktop, open the refill request document.
2. Click the button.
3. Click the button.
4. Select the *eSM RX Refill encounter type from the Append Document window and click OK.
5. Click the denied new to follow radio button.
6. Click the button.
7. Add or change the medication with the correct amount of quantities and refills.
   
   NOTE - Make sure the pharmacy listed for the prescription matches the pharmacy requesting the refill.

8. Click the button.
9. Click End Update.
10. Click the Sign Document button.
Dose Check/Sig Parsing

Once a medication has been selected and instructions have been entered, a second icon will display in the define medication section of the window.

1. The Formulary will inform the user the compatibility of the medication selected for the type of insurance the patient has.
   2. Green: compatible
      3. Yellow: compatible, but will have a higher co-pay
      4. Red: Not compatible

Click on the icon to open Drug Dosing Suggestion window.

1. The Drug Dosing Suggestion window will display the entered dose, the suggestion dosing limits, and the medication instruction signature. If the prescriber wants to override the suggestion, they will click the Override button. If the prescriber wants to change the dosing instructions then they will click Close.
2. If the prescriber has selected to override the suggested dosing limits, then the icon will still display yellow or red but will now have a green check indicating it was overridden.
3. Once a user has overridden a medication for a patient, it will not have to be done again for this medication and patient.
4. If any medication interaction was overridden, the information will also display on the Medications tab of the chart.
5. There is a preference selection for Med Interactions: Always apply prior override reason.
Importing Medication History from Sure Scripts

1. Click the Med HX... button.
2. Verify a consent has been signed by the patient to obtain a medication history, then select “consent granted by patient” from the Consent Status drop down.
3. Select a Date Range. If a range is not selected, it will bring in the last 2 years.
4. This will take 3-5 minutes, so it should be done at the beginning of the update.
5. Select medications you would like to bring into the patient’s EMR and then click the “Add to Current Meds” button.
6. The Add Medication Screen will open.
7. Review all information and click “OK”.
8. You will return to the Medication HX screen where you can continue to select medications to add.
Managing Allergies

1. While in a chart update, click on the Update Allergies icon.
2. If the patient has no known allergies, click the box next to the statement “This Patient has no known allergies.”
3. To change an allergy, highlight the desired allergy you wish to change and click the Change... button.
4. To remove an allergy, highlight the desired allergy you wish to remove and click the Remove... button. A Remove Allergy dialog form will appear for completion.
5. To add new allergy, click the New... button.
6. The New Allergy screen will appear. Choose the allergy from the drop down list or from the Reference List by clicking on the Reference List button and searching for the medication. If the allergy is a food or environmental allergy, just type it in the Allergic to: field (this will be recorded as an uncoded allergy).
7. Complete the New Allergy screen by adding a description, symptoms and onset date. If you wish to cancel the allergy information you just added, click Cancel.
8. To complete the addition of the new allergy, click the OK button.
9. Always check “Allergy list reviewed during this update” for MU requirements.
Managing Problems

1. While in a chart update, click on the Update Problems icon.
2. Select a problem to assess and click on a radio button for Improved, Unchanged, Deteriorated, and Comment Only.
3. To change a problem, highlight the desired problem you wish to change and click the Change... button.
4. To remove a problem, highlight the desired problem you wish to change and click the Remove... button. A Remove Problem dialog form will appear. Click OK.
Managing Problems (cont’d)

5. Adding a New Problem

There are three problem search options available when adding/changing the problem list.

- Existing problem custom lists
- Full Reference List
- *Smart List (A new form of custom list, which customizes a user’s problem list based on codes frequently used by the user.) A problem can **ONLY** be added to a user’s *Smart List by adding that problem three times to a signed document.

To add a problem using the existing problem custom list:

1. While in a patient’s chart, click the problems button.

(Please Note: The “Problems” button is still available in various forms.)
Managing Problems (cont’d)

2. Click “New” to add a new problem.

3. Select from the drop-down list labeled “Using”.

4. Perform search by placing the cursor in the “Search for” field and pressing the down arrow on your keyboard or begin typing the problem and selecting from the list that appears.

5. Once the desired problem is selected press “OK” to finish or “Save and Continue” to add additional problems.
Managing Problems (cont’d)

To add a problem using the full reference list:

1. While in a patient’s chart, for instance on the HPI-CCC form, click the problems button.

2. Click “New” to add a new problem.

3. Select your respective specialty from the drop-down list from the “Using” field.

4. Click the magnifying glass in the field labeled “Search for”.

5. After the “Find Problem” pop-up appears, click the magnifying glass in the field labeled “Search for” or type desired problem before clicking the magnifying glass.

Please Note:

- Problems can also be searched by typing the ICD-9 code in the field labeled “Search for.”
- At this time, search and add ICD-9 codes only.
Managing Problems (cont’d)

6. Select desired problem from the reference folder and click “OK” to complete or “Save and Continue” to add additional problems.

Please Note: Problems are housed within Chapters, Blocks and Groups. For instance, a user must first select from chapter folders. The user will then be directed to a second set of folders labeled Blocks. Finally, the user will select from the group which houses the code. A user’s selections are tracked and shown above the description box.
Managing Problems (cont’d)

To add a problem using the *Smart List:

1. While in a patient’s chart, for instance on the HPI-CCC form, click the “Problems” button.
2. Click “New” to add a new problem.
3. Select “*Smart List” from the drop-down list from the “Using” field.
4. Begin to type the problem in the “Search for” field and select the desired problem once it appears.
5. Click “OK” to complete or “Save and Continue” to add additional problems.

Please Note:

- Always check “Problem list reviewed during this update” for MU requirements.
- To return to the chart update, click OK.
Updating the Flowsheet

1. While in a chart update, click on the Update Flowsheet icon.
2. To change the appearance of observations on the patient’s Flowsheet, enter the name of the Flowsheet or click the drop down to select the Flowsheet you want to update.
3. To change an observation, select the observation you wish to change and press Change.
4. To remove an observation, highlight the desired observation you wish to remove and click the Remove button. A Remove Observation dialog form will appear for completion. Click OK to proceed.
5. To add a new observation, click on New.
6. The New Observation screen will appear (Check the date and change if necessary) and enter the appropriate observations.
7. If you wish to cancel the observation information you just added, click Cancel.
8. Click OK.
9. To return to chart update, click OK.
Join a Chart Update

1. While in a patient’s chart, click the button.
2. Click the button.
3. Enter the necessary update and click the button.
4. Click the button to sign off on the chart or click to hold the document and route at a later time.
Letters

1. While in a patient’s chart, click the button.
2. Under the Print Topic, double click on the letters folder.
3. Double click the SOM folder.
4. Click your department folder and highlight the desired letter from the Print Items list.
5. Click .
Orders

Order Entry Form Launch

Should a provider need to process an order, they may do so within an active Office Visit form the “Order Entry Form Launch”.

1. Click the button for the desired Specialty.

2. The user will then be able to view the “Order Entry” form for the specialty chosen.

(Please Note: While on this form, the user will be able to navigate to any of the 5 tabs.)
Orders – LABS

LABS
Labs (LabCorp, Quest or Kennedy)
Ordering Option 1 – Manual Lab Order

1. Click the tab of the desired Lab vendor.

2. Select a problem from the “Diagnosis” drop-down list.
   (Please Note: you cannot select a lab order button without a corresponding problem)

3. Once the problem is selected, click the button for the lab order you wish to order.
   (Please Note: If you have multiple labs you wish to order for the patient, make sure you have the appropriate diagnosis selected in the dropdown and continue to click additional lab buttons.)
Orders – LABS (cont’d)

Ordering Option 2 – Lab Order Set

1. Follow steps 1-2 on the previous page.

2. Click the desired lab order button listed below the “Order Sets” Heading. (Ex.: Macrocytic Anemia)

Please Note: Clicking on a lab order button will produce multiple lab orders that were preselected by a member(s) of each department.

Please Note: Order Set buttons do not “grey out” however, the single test button that were ordered in that particular lab order set will “grey out.” See above screenshot where single buttons “grey out.”
Orders – LABS (cont’d)

Adding Instructions for Labs

1. From the “Order Entry” form, click the “Go To Orders” button. Doing this displays the “Update Orders” dialogue box.

2. Highlight the order for which you want to add instructions. (Be sure to be on the “Orders Details” tab.)

3. Type instructions in the Instructions field. These instructions will be included on the lab requisition that will print from the EMR.
Orders – LABS (cont’d)

Labs – Other (Not LabCorp, Quest or Kennedy)

1. From the “Orders Entry” form, click on the “Go To Orders” button.
2. When the “Update Orders” dialogue box appears, click on the tab labelled “Categories”.
3. Make sure the radio button labelled “Test” is selected.
4. Select the Category “OTHER LABS”. Then select the desired lab order, followed by clicking the “Enter” button.
Orders – LABS (cont’d)

5. After entering the order, add the corresponding problem from the “Potential Diagnosis” box by highlighting the problem and clicking the add button.

6. While on the “Order Details” tab, enter any necessary instructions in the “Instructions” box. Select an external lab service provider, if one has been selected at this time.

(Please Note: if the user does not know the laboratory the patient will be going to, or if it is not loaded in the service provider table, simply use the default of “Other Laboratory (Laboratory-Other)” and free text the name of the lab in the “Instructions” box.)
Orders – Radiology

Radiology Studies
1. While on the “Order Entry” form, navigate to the Rad tab.
2. Select a problem from drop-down list.
   *(Please Note: you cannot select a radiology order button without a corresponding problem.)*
3. Once the problem is selected, click the button for the lab you wish to order.
4. Select a radiology study. While still on the “RAD” tab, click the colored button for your corresponding “Referral” desktop location.
Orders – Radiology (cont’d)

Pre-Authorization of Radiology Studies

Once the button for the desired location is clicked, Ex. FPSTRAT, a flag will go to the desktop of the chosen location.

1. The staff member managing the “Referral, FPStrat” Desktop will double click on the flag when ready to begin the preauthorization process.

2. Double clicking on the flag will take the user to the patient’s chart.

3. Navigate to the “Orders Tab” of the patient’s chart.

Please Note:

- As long as the provider has signed the Radiology Study order that needs to be pre-authorized, the order should be in the Orders tab. If it is not there yet, the provider may not have signed the rad order.

- If there are multiple orders for that patient on the orders tab, look for that radiology order from that DOS.
Orders – Radiology (cont’d)

4. Highlight the radiology order and then click the “Change” button.

5. The “Change Test” dialogue box will appear. The user will complete the necessary fields as per their location’s preauthorization workflow (i.e. Administrative Comments/Authorization Number). If no preauthorization is needed, then change the status to “In Process.”

6. Once complete, click “OK”.

Please Note: Once the preauthorization information is documented in “Change Test” dialogue box, be sure to go back to the “Referral, FP Strat” desktop and remove that flag.
Orders - Referrals (External and Internal)

External Referrals – EP Workflow

1. While on the “Order Entry” form, navigate to the “RAD and REF” tab.

2. The user must then select the location of care for which they are practicing. *(Please Note: The colored buttons represent the various locations)*

3. Click the “Referrals” button located at the top, right of the form.
Orders - Referrals (External and Internal) (cont’d)

4. The “Update Orders” dialogue box will appear and default to the “Referrals” custom list.

5. Select the checkbox for the specialty for which you are referring to.

6. Attach a problem to the referral order by highlighting the problem and clicking the add button.
Orders - Referrals (External and Internal) (cont’d)

7. Navigate to the “Order Details” tab.
   *(Please Note: It is on the “Order Detail” tab where the provider will be able to select who they are referring the patient to and any other instructions that are necessary.)*

8. The referral will always default to “External” as indicated by the radio button and the check box for “Create Transition of Care Document” will always default with a checkmark in it.

9. Always complete the “Reason” field for **ALL** external referrals.
   *(Please Note: The “External”, “Create Transition of Care Document” and “Reason” field are all required for MU II Core 15-Transition of Care OUT.)*

10. If the provider knows who the external service provider is that they are going to refer their patient to, they can click the button to obtain a list of all service providers or they can leave the field blank and the support staff can choose a referral during the “Working a Referral” process.

   *(Please Note: All referrals will be defaulted to a disposition of “In Process” in order for the referral to print.*
Orders - Referrals (External and Internal) (cont’d)

11. If the provider decides to choose an external provider at this time, click the button. The “Select Service Provider” dialogue box will appear.

12. The provider will need to manually search and select the “external” provider that they are referring the patient to.

13. When the “external” provider has been selected, press “OK”.

14. That external provider’s name will then appear on the “Order Details” tab.
Orders - Referrals (External and Internal) (cont’d)

Referral Quick Text

A Global Quick Text was created in order to make the referral process easier. The quick text will allow the user to view the patient’s name, insurance company and insurance ID without having to change screens.

Within the orders module, on the Order Details tab, there is an instructions field. Type the quick text .ref in the instructions field.
Orders - Referrals (External and Internal) (cont’d)

Internal Referrals – EP Workflow


2. Click the “Internal Provider” radio button and select a Rowan-SOM provider from the drop-down list.
   
   (Please Note: You may have to use the binoculars to search all Internal Rowan-SOM providers)

   ![Image of the EMR system interface showing the Referral Administration section with the Disposition set to "In Process".]

   Please Note: All referrals will be defaulted to a disposition of “In Process” in order to print.
Orders - Referrals (External and Internal) (cont’d)

To complete the referral process and to Route a flag to the referral’s coordinators desktop, at the end of the external or internal referral process, do one of the following:

1. Click the “Sign Orders” button on the “Order Details” Tab.

   -OR-

2. Click “OK” on the “Orders Detail” tab, which will bring you back into the active office visit note.

3. When the charting process is complete, click the “End Update” button. In the “End Update” pop-up.

   ***Make sure the checkbox for “Sign Clinical List Changes” is checked.***

4. Click “Sign Document” -OR- “Hold Document” and the referral will be routed to the Referral Coordinator.
5. **Orders - Referrals (External and Internal) (cont’d)**

**External Referrals – Admin Workflow**

*(IMPORTANT for MU II Core 15-Transition of Care OUT)*

1. Using the previous example, once the referral is signed, a flag will go to the “Referral, FPStrat” desktop.

   ![Diagram of EMR system](image)

   ![Diagram of EMR system](image)

   ![Diagram of EMR system](image)

   ![Diagram of EMR system](image)

   ![Diagram of EMR system](image)

2. The staff member managing the “Referral, FPStrat” Desktop will double click on the flag when ready to begin working the referral.

3. Double clicking on the flag will take the user to the patient’s chart.

4. Navigate to the “Orders” Tab of the patient’s chart and locate the referral.

   ![Diagram of EMR system](image)

   ![Diagram of EMR system](image)

   ![Diagram of EMR system](image)

   ![Diagram of EMR system](image)

5. Highlight the referral order that needs to be worked and then click the “Change” button.

6. The “Change Referrals” dialogue box will appear.
Orders - Referrals (External and Internal) (cont’d)

7. In the “Administration” section of the “Change Referral” Dialogue box, if the “External” radio button is selected, the following fields must be completed in order for the Eligible Professional to receive MU credit:

   a. “Referring To” (Service Provider) field – If the physician did not select an external provider, they must do so at this point.

   b. “Reason” field - If the physician did not document the “reason” for the referral, they must do so at this point.

   Please Note: If an external Service Provider is not listed in the Service Provider table, the user can do one of the following to have them added:
   
   - Send a flag to the IST Triage desktop
   - Send an email to somemrhelp@rowan.edu
Orders - Referrals (External and Internal) (cont’d)

Because a referral to an external provider is considered a transition of care, the user will be prompted to generate a transition of care document.

8. Click the “Save & Create” button to generate the “Transition of Care” document.
   
   (*Please Note: The [Save & Create] will not appear unless an external service provider has been chosen and this button must be clicked for MU credit.)*

9. Click “Save To Chart & Close” button. This will bring the user back to the “Change Referral” dialogue box.

   ***Important Note: Remember to notify the ordering provider of the external referral, via EMR flag. (This process can only be completed by an LPN or higher.) If they wish to send the CCDA via clinical messenger, they will need to do so via the Clinical Messenger Tab. This will get them credit for MU Stage 1 Menu Measure 7 or MU Stage 2 Core 15.***

10. Collect additional information in order to process referral. (i.e. Navinet info, authorization #s, etc.) Once collected, input this information into the “Administrative Comments” box and the “Authorization Number” field which are located at the bottom of the “Change Referral” dialogue box (Note: this is not needed for MU).
Orders - Referrals (External and Internal) (cont’d)

11. Once everything is completed, click “OK” to complete the process.
Orders - Referrals (External and Internal) (cont’d)

Internal Referrals – Admin Workflow

1. Follow steps 1-6 in the previous workflow for “External Referrals – Admin Workflow”.

2. In the “Administration” section of the “Change Referral” Dialogue box, Verify if the “Internal Provider” radio button is selected, that an Internal Service Provider has been chosen from the drop-down list.

   (Hint: you may have to use the binoculars to search all Internal Rowan-SOM providers)

3. Follow steps 11-12 in the previous workflow for “External Referrals – Admin Workflow” to complete the process.
Orders – Billable Service

Billable Service (CPT codes)

1. Navigate to Billing Tab.

2. Select a problem for the patient in the drop-down list
   *(Please Note: You cannot select a service order button without a corresponding problem.)*

3. Once the problem is selected, click the button for the service order you wish to order for your patient.

***Please Note: This process will be “Going Live” at a later date.***
Orders – Adding a Modifier

1. Click on the “Go To Orders” button.

2. Highlight the order for which you want to add a Modifier.

3. On the “Order Details” tab, click the “Add Modifiers” button.

4. The “Select Orders Modifiers” dialogue box will appear. Highlight the modifier you wish to choose, click “Add”, then “OK”.

[Instructions on how to add a Modifier]
Orders – Adding Multiple Diagnoses

Adding Multiple Diagnoses

1. Highlight the order for which you want to add additional diagnoses.

2. Then select the additional diagnosis from the “Potential Diagnosis” section and click the add button.

3. Continue this process for all additional diagnoses that need to be added.

If there is a diagnosis you need added to the “potential diagnoses” list, you can click this button to add a problem.
Orders – Other Labs, Rads & Tests

Labs, Rads and Tests not found on “Order Entry” form
When a user is unable to locate an order on their specialty’s “Order Entry” form, an order can be ordered by one of the following options.

Option 1 - Utilizing the [Other] buttons
1. Choose a problem from the “Order Entry” form.
2. Click [Other (must free text lab in CPOE)].
3. Click the “Go To Orders” button.

![Image of EMR Order Entry Form]

- Blood Studies
- Hematology
- Microbiology
- Other
Orders – Other Labs, Rads & Tests (cont’d)

4. In the free text “Instructions” field, type the lab you wish to order.

5. Proceed with regular orders workflow.
Orders – Other Labs, Rads & Tests (cont’d)

Option 2- Searching the Lab or Rad Compendium For “other” Orders

1. From the “Order Entry” form, click the “Go To Orders” button.
2. The “Update Orders” dialogue box will appear, click on the tab labelled “Categories”.
3. Be sure the radio button labelled “Test” is selected.
4. Select a Category, the desired lab order and click the “Enter” button.
5. Proceed with regular orders workflow.

(Please Note: The labs categories are according to vendor, while the radiology category is according to modality.)
Orders – (Not Labs or Rads)

Other Orders (Not Labs or Rads-i.e. DMEs)

1. Click on the “Go To Orders” button from your specialty’s “Order Entry” template.
2. Select from the “Use Custom List” dropdown the custom list for DME/Other.
3. Select the checkbox for the DME you are ordering.
4. Attach a problem to the referral order by highlighting the problem and clicking
Orders – (Not Labs or Rads) (cont’d)

5. Navigate to the “Order Details” tab.

6. The DME order, like referrals, will always default to “External”.

7. If the provider knows who the external service provider is that they are going order the DME from, they can click *** to obtain a list of all service providers or, they can leave the field blank and the support staff can choose a referral during the “working a referral” process.

8. All DME orders will default to an “Admin Hold” disposition, which will cause a flag to be sent to your referral coordinator’s desktop. If the DME does not require an approval/authorization, and would just like to print the requisition to give to the patient, simply change the above “Admin Hold” disposition to “In Process” and make sure an external service provider has been chosen.
Orders – “Orders Only” Encounter Type

Orders Only Encounter Type

The “Orders Only” Encounter Type is new to the EMR and will be used for Orders. It will include a “Phone Note” template and the “Order Entry Launch” template and will only be able to be signed by Physicians. To Locate the Order Entry Encounter Type, follow the following process:

1. After clicking the “Update” button, the below “Update Chart” dialogue will appear.
2. Select the Encounter Type for “Orders Only” and press “OK”.
3. Proceed with Orders workflow.

![Update Chart Dialogue](image)
Orders – CPOE A&P-CCC Form

CPOE A&P-CCC Form and Orders

After all orders have been entered, the next form in the sequence will be the CPOE A&P-CCC form. This form ties all orders to their respective diagnoses. The values in this form auto populate based on information entered in the “Update Orders” form. Additional tabs house the additional A&Ps. The user can continue to free text additional information regarding the Assessment and Plan for that particular diagnosis. When this is complete, click the “Commit Assessment” button for each assessment.
Orders – Signing Orders

Signing Orders

During any point in an update, you can sign your orders. There are 3 dispositions the order will default to: In Process, Admin Hold or Complete. The details of each disposition are listed below:

1. “In Process”. When a Lab or Rad order is signed, they default to an “In Process” status, and a requisition will automatically print for the patient.

2. “Admin Hold”. When a Referral order is signed, it will cause a flag to go to that ordering provider’s LOC Referral Coordinator Desktop. No requisition will print.

3. “Complete”. When a service/billable order is signed, the complete status will cause an interface message to be sent to the Centricity Business system.

Signing your orders from the “Update Orders” Dialogue

After all orders have been entered, click the “Sign Orders” button on the “Order Details” Tab.
Orders - Signing Orders (cont’d)

Signing your orders when you put the update “On Hold” or “Sign” the update

If a user chose not to sign the order from the “Update Orders” form; they may do so at the close of the office visit.

Click the “End Update” button. In the “End Update” pop-up window, make sure the checkbox for “Sign Clinical List Changes” is checked and select either “Sign Document” or “Hold Document”.

(Please Note: Because orders are considered “clinical list changes” they will be signed at this point.)

Please Note:

- Signing an order will cause it to go to one of the three predetermined dispositions noted in the beginning of this section which is either: In Process, Admin Hold or Complete.
- Orders are set up to print forms automatically when the order is signed. Orders can also be printed from the orders tab, within the patient’s chart, by highlighting the order and clicking the “print” button.
Orders - Setting Orders to “Complete” Status

Setting Orders to a “Complete” Status

Results Requiring Scanning

Once the paper test result is returned to the office, the user will look up the patient’s name in the EMR and write the MRN on the test result so it can be scanned and indexed into the EMR. (Please Note: Per the office’s respective workflow, the physician may or may not have already signed that particular test result before it is scanned.)

1. Before scanning the document, go the patient’s EMR chart and click the “Orders” tab.

2. Locate the desired order and highlight the order.

3. Because the paper result was received for that particular order, the user can click the “Complete” button.
Orders - Setting Orders to “Complete” Status (cont’d)

4. The “Select Orders to Complete” dialogue window will pop-up. In the “Select” Column, check the checkbox for the order you would like to complete. *(The checkmark will default if the user highlighted the order when clicking the “complete” button)*

5. Click the “OK” button. This will complete the order and remove it from the active/open orders list.
Orders - Setting Orders to “Complete” Status (cont’d)

Interfaced Results

1. On the respective department/location’s Triage Desktop will be unsigned lab results from LabCorp, Quest and Kennedy Health Systems.
2. Before routing the lab result to the responsible physician’s desktop, go the patient’s EMR chart and click on the “Orders” tab.
3. The user should locate the order for the respective result that they are viewing and highlight that particular order.
4. Since the interfaced result has been received for that particular order, the user can click the “Complete” button.
5. The “Select Orders to Complete” dialogue window will pop-up. In the Select Column, check the checkbox for the order you would like to complete.
6. Click the “OK” button. This will complete the order.
Managing Lab Results

Abnormal Lab Results

1. Patient chart will be open – Click and select the On Encounter Type screen Select > PHONE NOTE.
2. Complete appropriate fields based on clinic’s workflow.
3. Click on close. Review the textual note.
4. Click on End Update icon.
5. Complete the Summary Line with a summarized reason for the call, (i.e. abnormal CBC).
6. Route document to appropriate provider or sign.
Normal Lab Results

1 Log onto Centricity EMR.
2 Go to the Documents Tab.
3 In the “View Documents To” field, select the Triage Folder name for your location (i.e. Triage, Fam Med Stratford).
4 Highlight the lab result you wish to review.
5 In the Document View area, review the lab for Ordering Physician.
6 Route to the appropriate provider for review and signature, escalate as necessary.
7 End Process.
Managing Lab Results (cont’d)

Lab Letters

To send a lab letter when results are received:

- From the patient chart click the print button.
- This will open the print screen.
- Select Letters
  - Select letter requested
  - Click the Customize button
  - This will open the letter for viewing and personalized notes within the letter. The lipids letter will pull in applicable lab results. Make changes, click “save as a document in chart”, verify correct printer is selected and click print.
WORKING IN A
CHART UPDATE
Working in a Chart Update

Special Functions

1. Start a chart update by clicking on (in the middle of your screen).

2. While in a chart update, press the right mouse button to view the choices available.

3. To perform a spell check on your update, click **Spelling**.

To change document properties, click **Change Properties** and change any or all of the following: document type, provider, confidentiality type, location of care, clinical date, clinical time, visit ID, attachments, summary, has pending transcription. Click **OK** to accept the changes.
Working in a Chart Update (cont’d)

Generating a CCD (Continuity of Care Document)

Patient request that they would like a paper copy of their health information. SOM Staff advises patient that “Authorization for Release of Patients Records” form must be completed, signed and returned to the office, with original ink signature. SOM Staff will provide (mail, fax, hand deliver) patient with Authorization form by following the steps below.

3 Log on to Centricity EMR.
4 Go to patient’s chart.
5 Open Phone Note and document the request in “Summary of Call” section in Phone Note.
6 Close Phone Note.
7 Go to .
8 Route Phone Note to File Clerk/Med Record Staff (different in each dept.) who will handle electronic health information request.
9 Patient returns authorization form to the department, since the authorization form has “electronic” written on it, the staff knows to give that request to the File Clerk/Med Record Staff.
10 The File Clerk/Med Record Staff receives signed auth form and knows since it is “electronic” request that 3 days from receipt they must provide the CD to the patient.
11 File Clerk/Med Record Staff logs onto Centricity.
12 Go to desktop and identify and open original “on hold” Phone Note that was created for the patient requesting electronic copy of health info.
13 In Update, open “Patient Authorization” form.
14 On the “Patient Authorization” form check all appropriate fields for MU reporting.
15 Close “Patient Authorization Form”.
16 Click .
17 Route document to physician for final signature
18 From the Summary Tab in the patient’s chart, go to Actions>Generate Chart Summary.
19 Select “Reason for Export” and “Name of Recipient”.
20 Check the Compressed File (.zip) box and create a password in the “passphrase (optional)” box.
21 In the “Export Destination” field, select desktop.
22 Complete “Include Observation” section if necessary.
23 Click to complete.
Generating a CCD (Continuity of Care Document) (cont’d)

24 Insert blank CD into machine.
25 Go to desktop and right click on patient’s chart summary document, click on send to CD Drive (E:).
26 Go to My Computer and then go to CD Drive (E:).
27 Highlight file(s) that you want to burn to CD.
28 When the file is highlighted, go the left column and click on “Write these files to CD”.
29 Follow the CD Writing Wizard pop-up instructions and the files will be written to the CD
   When complete, eject CD and provide to patient.
Decision Support Protocol

The following is a description of the future “to-be” process in Centricity to satisfy Meaningful Core Requirement “Implement Clinical Decision Support Rule”.

After a clinician opens any patient’s chart they will click on the protocol icon.

Then automatically one of the following protocols will activate and display recommendations based upon the patient’s age and gender. Every patient in the current and future database will fall into one of these categories.

1. USPS Birth to 10 Years
2. USPS Ages 11-17
3. USPS Ages 18-24 Females
4. USPS Ages 25-44 Females
5. USPS Ages 45-49 Females
6. USPS Ages 50-64 Females
7. USPS Ages 65-68 Females
8. USPS 69 Yr. & Older Female
9. USPS Ages 18-24 Males
10. USPS Ages 25-34 Males
11. USPS Ages 35-49 Males
12. USPS Ages 50-64 Males
13. USPS 65 Yrs. & Older Males

The appropriate USPS protocol will display preventative care recommendations like as follows. It will display the appropriate protocol name, it will list each recommendation and the status.

This tool is constructed for the purpose of clinical decision support as per Meaningful Use and will be instrumental in the decision process of Rowan SOM clinicians to order or not order tests and services for patient’s at the point of care.
SCANNING
Scanning Multiple Documents

1. Open ScandALL PRO and go to **Scan>Scan Settings**.

2. Click the radio button **Save all pages to one(1) file** or the button **Divide a document into files, each consist of**.

**NOTE** - If all pages scanned need to be entered as one document into the patient’s chart, click the radio button “Save all pages to one(1) file”. If you have multiple pages that need to be scanned, but will be entered as a single document within the patient’s chart, click the radio button “Divide a document into files, each consist of” and the amount of pages each document will consist of.
Scanning Multiple Documents (cont’d)

3. Load the documents face down and click the Scan button at the bottom of the Scan Settings window.

4. Click the OK button to close the Scan Settings pop-up window.

5. Minimize the ScandALL PRO window and double click the Indexing Client icon on the desktop designated for scanning.

NOTE- you will enter your username and password that is assigned to you for the EMR.

6. Once the Indexing Client is opened, click on the Index tab.

7. Location of Cares will default in the prompt next to the Path button. If you scan in more than one Location of Cares, you can click the drop down menu to select the correct location.
8. Click the Refresh button.

9. All document scanned will display in the Available Files(0): box.

10. Click on the document that will be indexed to Files to Import(0): box and click the single arrow.

11. Under Document type: click the drop down menu and select the appropriate document type.

12. The Destination: prompt will default to EMR. Accept the default.
Scanning Multiple Documents (cont’d)

13. At the Clinical date: prompt, type in the Date of Service or click the drop down menu to select a Date of Service.

14. At Summary: the user can free text a summary or click the drop down menu to select from the list.

   NOTE- Please refer to the Rowan Faculty Practice Plan Operations for Scanning and Indexing Document into the Centricity Electronic Medical Record.

15. Click on Lookup Patient (F4).

   NOTE: The best way to lookup a patient is using the 3-2 method (XXX,YY) to make sure the document is imported to the correct chart.


17. The check will display in the check box for Import as signed. Accept the default.

18. The user will then proceed to the Physician: prompt. Click the drop down menu to select a Physician or the user can type the Physician’s name by typing the first few letters of the last name.

19. Make sure the Location of Care: prompt has the correct location. If not, the user can click the Clear button and enter the correct location.

20. Click on the Import Document (F9) button to import the document.

21. The next document to be indexed will automatically move into the files to Import box, and the process can be repeated.
MESSAGING TAB
Messaging Tab

Accessing the Messaging Tab
After you successfully log into the EMR, click on the messaging tab to access the secure messaging for your location of care. Your user ID and password is a onetime log-in. Enter your EMR user name and generic password of portal123.

1. Log onto EMR.
2. From the user’s desktop, a new tab has been added “Messaging”.
3. Click the Messaging tab.
4. Enter User ID.
5. Enter generic password.
6. Click on the Remember my EMR ID.
7. Click on the Log In button.

Please Note: Please remember to check off the “Remember my EMR ID” box.
**Messaging Tab (cont’d)**

**Viewing the Messaging Tab**
The Messaging Tab consists of Tool Bar at the top which consists of **Back**, **Forward**, **Stop** and **Refresh** buttons. These icons work as if they would on any general website. Below these buttons is a menu bar which tells you which mailbox you’re logged into and the folder you’re viewing. There is also a menu bar column on the left which lists the “Messages” options, the “User” options and the “Delegate” options available to the user.

To the right is the messages pane. All incoming messages will be listed in this pane. Below the list of messages is a preview of the current message highlighted. All unviewed (new) messages will appear bolded in the message pane.
Messaging Tab (cont’d)

Composing a Secure Message

There are four secure message types:

1. **Standard** – A secure message intended for an outside provider/office.
2. **Patient** – A secure message intended for a patient.
3. **Template** – A secure message template that has pre-populated fields.
4. **Referral** – A secure message intended for an office/provider with an attachment of patient information for a specialist referral.

**To Send a Standard Message:**

1. Hover over the **New Message** button and select **Standard** from the drop menu to the left of the new message menu.

2. Enter the Email address in the **To** field or Click the **To** button to open the **Address Book**. Choose the email address by clicking the checkbox next to the recipient name.
Messaging Tab (cont’d)

3. Complete the Subject and Message text and click the **Send** button.

**To Send a Patient Message:**

1. When sending a message to a patient, **always** start from a patient chart. This will ensure that you are sending a message and secure chart information to the correct patient. **Note:** The only way to change the patient email address is to go to the newly selected patients chart.
2. Hover over the New Message button and select Patient from the drop menu to the right of the new message menu.
3. The patient’s email address (if one exists in their registration), will automatically populate the **To** address field. If the patient does not have an email address in his/her registration a “no email found” will display after the patients name on the message tab screen.

Example: No email address in a patient’s registration.

4. Complete the **Subject**.
5. Type your message in the **Message** field.
Messaging Tab (cont’d)

6. To attach a document from the patient’s chart, click the EMR Chart Tab. This tab will display all patient documents in their chart. To send the Chart Summary, check the Attach Chart Summary checkbox.

7. You may also choose from the list of documents and check the box next to the document(s) you wish to attach to your secure message.

8. Click the Send button.
Messaging Tab (cont’d)

To Send a Secure Message Using a Template:

1. Click on the **Messaging** Tab.

2. Hover over the **New Message** Button and select a template under the **Templates** heading.

3. A new secure message will open with the **Subject** and **Message** fields populated with the text of the template.

4. Enter the email address of the recipient in the **To** field.

5. Click the **Attach Documents** button in the upper left corner.

6. To have the **Secure Message** be added as a document in the patient’s chart, click the **Cc Chart** Button.
Messaging Tab (cont’d)

7. Complete the fields and click the **Done** button.

8. Click the **Send** button.

*Please Note:* Chart documents can also be attached to template messages.
Messaging Tab (cont’d)

To Send a Referral (Transfer of Care) Secure Message

1. Hover over the New Message button and select Referral from the pop out box.

2. To access the SureScripts directory of outside provider email addresses, click the To button. An Address Book window will open.


```
how: Surescripts Directory
```

4. Enter the name or organization of the provider or office of the recipient in the Search text box.

5. Check the box next to the recipient’s name under the To column and click OK.

```
[Check box] Heather Baye
[Check box] Tasnim Beg

<table>
<thead>
<tr>
<th>To</th>
<th>Cc</th>
<th>Bcc Name</th>
<th>Organization</th>
<th>Specialty</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Heather Baye</td>
<td>GENERAL PSYCHIATRY CHERRY HILL</td>
<td>Psychiatry</td>
<td>7 mi.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tasnim Beg</td>
<td>Crozer Ctr Family Hlth Springfield</td>
<td>Family Practice</td>
<td>20 mi.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tasnim Beg</td>
<td>ChesPerr Ctr for Fam Hlth at UD</td>
<td>Family Practice</td>
<td>19 mi.</td>
</tr>
</tbody>
</table>
```

6. Type your message in the Message field.
Messaging Tab (cont’d)

To Send a Referral (Transfer of Care) Secure Message (cont’d)

7. Click the **EMR Chart** Tab. This tab will display all patient documents in their chart, and a checkbox to attach the patient’s **Chart Summary**. To attach the **Transition of Care** document, scroll to the appropriate office visit date. To display the actual Transition of Care document, expand the office visit document by clicking the gray arrow next to the checkbox. Mark the checkbox next to the Transition of Care document. To send the **Chart Summary** in addition to the Transition of Care document, check the **Attach Chart Summary** checkbox.

<table>
<thead>
<tr>
<th>Message</th>
<th>EMR Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Documents for AGAIN TST</td>
<td>Add Attach Chart Summary</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>Clinical Date</td>
<td>Type</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>07/22/2014 07:34 AM Ofc Visit</td>
<td>[No Summary]</td>
</tr>
<tr>
<td>07/22/2014 14:23 PM Ofc Visit</td>
<td>[No Summary]</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>07/22/2014 14:24 PM Prog Exp</td>
<td>Transition of Care</td>
</tr>
<tr>
<td>☑</td>
<td>☑</td>
</tr>
<tr>
<td>07/22/2014 14:18 PM Ofc Visit</td>
<td>[No Summary]</td>
</tr>
<tr>
<td>07/22/2014 14:15 PM Ofc Visit</td>
<td>Annual Medicare Wellness Visit</td>
</tr>
<tr>
<td>07/22/2014 14:11 PM Ofc Visit</td>
<td>[No Summary]</td>
</tr>
<tr>
<td>07/21/2014 10:37 AM Order</td>
<td>Orders Only</td>
</tr>
<tr>
<td>07/16/2014 11:15 AM Ofc Visit</td>
<td>[No Summary]</td>
</tr>
<tr>
<td>07/16/2014 10:34 AM Ofc Visit</td>
<td>[No Summary]</td>
</tr>
<tr>
<td>03/05/2014 00:00 AM CTSCAN</td>
<td>Cat Scan RPT</td>
</tr>
<tr>
<td>02/26/2014 00:00 AM Clin Updt</td>
<td>Mammogram Rpt</td>
</tr>
<tr>
<td>02/16/2014 00:00 AM Clin Updt</td>
<td>Mammogram Rpt</td>
</tr>
</tbody>
</table>

8. Click the **Send** button.
Messaging Tab (cont’d)

Sending a Secure Message With a Patient Document via SM-Basic Encounter Type from the visit update.

1. While in the patient chart, click on Documents Tab.
2. Choose the document to be sent to the patient.
3. Click the Append button.
4. Click the Click here to do a Full Update button.

5. Choose the SM Template Encounter Type and click OK.

6. A Secure Message template will open with the To email address populated with the patient’s email address (if one has been recorded in their registration). The Subject field will also be populated.
Sending a Secure Message With a Patient Document via SM-Basic Encounter Type (cont’d)

7. Type your message in the Message field.

8. To include the patient’s CCD as an additional attachment, check the Attach CCD checkbox.

9. Click the Close button.

10. Click the End Update button and sign the encounter by clicking the Sign Document button. When the encounter has been signed, the message will be sent to the patient.
Messaging Tab (cont’d)

Logging on to Shared Inboxes
Messages sent by patients from the patient portal will go to a location of care delegate mail box in the messaging tab (not individual user mailboxes). A delegate log in will be used to access the location of care delegate mailboxes. The shared inboxes will be worked just like the EMR triage folders.

1. Log onto the EMR and click on the Messaging Tab.
2. In the menu column under Delegates, click on the Delegate Log In link.
3. Select the desired Location of Care and click the Log In As Delegate button.
4. Click on the Log In As Delegate button.

Please Note: Upon entering the message tab right corner of the inbox messaging screen you will see that you are logged on as a delegate and the Location of Care you selected.
Messaging Tab (cont’d)

Change Delegate
To change from one location of care delegate mailbox to another location of care mailbox you must log out of the current delegate mailbox and log in a different location of care delegate mailbox.

After you click the log out button while in a delegate mailbox, you will be taken to your own mailbox in the messaging tab. To log into another location of care delegate mailbox, click the delegate login button under the “Delegates” heading.

Inbox Features
The Messaging Tab works much like e-mail. Messages within the Messaging tab may require different decisions. Depending on the message in the inbox, the user will need to resolve all messages to completion and/or delete the message. The user can also save a message to the EMR (convert the message to a document) and send to a triage folder or provider desktop.
Messaging Tab (cont’d)

Inbox Features (cont’d)

- **Reply, Reply All and Forward**: Allows the user to reply to messages from the Messaging tab.
- **Delete**: Allows the user to delete the message from the Messaging Tab inbox.
- **Print**: Allows the user to print the message from the Messaging Tab inbox.
- **Search**: Allows the user to search messages in the Inbox they are logged into.

Rather than clicking any of the listed buttons above from the Messaging Tab, the user can also select the appropriate action codes from using the keyboard.

**D** - Delete  **E** – Print

****Due to compliance, users are not permitted to Reply, Reply All, or Forward a message.****

Folders

All messages are to be resolved from the location of care delegate Inbox to provide optimal patient care. Do not move messages to any other folders.
Messaging Tab (cont’d)

Sending a Message to a Triage Folder (Save to EMR)
In rare instances users may want to save a message to the EMR that came in through the messaging tab. In this instance users can save incoming messages to the EMR and send them to a triage folder or provider’s desk top for review and sign off. These messages become documents within the legal chart.

Please Note: Once a message has been saved to the EMR, it must be deleted from the location of care delegate inbox.

1. On your desktop, click the Messaging tab.
2. Under the Delegate section, click on Delegate Log In.
3. Select the desired Location of Care and click the Log In As Delegate button.
4. Select the desired message in the Inbox Messages and double click to open the message. (You will not see the Action button unless the message has been opened by double clicking on the message)
5. Click the Action button and then click Save to EMR.
6. At the Select EMR Patient drop down menu, the system will default to the last opened patient chart.

Please Note: The user can also search for another patient by typing the name and clicking the search button. Same as you would open a chart in the EMR. Click the Select link to choose the appropriate patient.

7. Click the Select Provider drop down menu and type the desired triage folder/provider and click the Find button.
8. Select the desired triage folder/provider and click the Save to EMR button located in the top left corner.

Please Note: Messages saved to the EMR become documents and a permanent part of the patient’s chart.
PATIENT PORTAL
Patient Portal

The Patient Portal is a secure website that will allow patients to access medical information from the Electronic Medical Record (EMR), send messages to their providers or complete necessary online forms that can be electronically delivered directly to the EMR.

Patients will not require a portal PIN number to access the RowanSOM home page of the patient portal. This page will allow patients to print new patient forms to bring to their appointment for CB registration and pre-load. Additionally the portal has a contact us tab for patients to review a complete listing of all RowanSOM practice sites and specialties.

The portal will also contain RowanSOM links to disseminate information to the general public which includes direct url links to RowanSOM marketing and research information.

Logging On to the Portal

www.rowan.edu/som/patientportal

RowanSOM staff will generate a PIN for each patient in C-EMR using the PIN Generator encounter type. The EMR will print out a PIN generator document that is to be handed to the patient prior to the patient’s departure.

In order for patients to gain access to the portal, they must have their PIN generator document readily available, they will need the document to access the portal and they must complete the enrollment within 30 days or request a new PIN.

Welcome to the Patient Portal

Patients will gain access to the Patient Portal by going to the URL www.rowan.edu/som/patientportal. Upon entry to the RowanSOM home page patients must either click the ‘new users’ red star icon or the ‘Register to gain access to our secure online services’ link to begin the registration process.
Patient Portal (cont’d)

Portal Registration

The portal registration screen is the next step in gaining access to the portal. Users must read through the requirements on this page then click on the ‘Please click Here’ link.

Registration Consent

The patient must read and agree to the Registration Consent Form and click the Accept button to continue the registration process.

Please Note: On the consent form there is a link that provides a PDF of the Privacy Practice for Health Information.
Patient Portal (cont’d)

Create a New Portal Account
The patient will have to complete the required fields and click the Save button to continue the registration process.

Please Note: Employees who are patients MUST NOT use their Rowan email address to sign up for portal access. Employees must use a personal email address to gain access to the portal.
Patient Portal (cont’d)

Patient Verification
The patient will click the first radio button indicating that they ‘I have a PIN for my own chart and I have been seen here before or have an appointment’ and click the NEXT button to continue the registration process. The PIN number is located on the PIN generator document that is handed to the patient prior to their departure.

Please Note: The second radio button ‘I am verifying the identity of a family member, Use this link to Edit your Account and add family member’ is for family management and is outlined in the family management workflow.

Identity Verification
The patient will verify their identity by completing the required fields on the Identity Verification screen and click the Verify button.

Please Note: The First Name, Last Name, Birth Date, and Gender must be identical to the way it is entered into the EMR.
Patient Portal (cont’d)

Verify Identity Complete

The final step of identity verification is an informational page notifying the patient that they have successfully registered for the patient portal. On this page they have the option of clicking the ‘method of contact’ link or any other tabs in the portal.

After the Patient Portal Registration is complete, the patient will have the option of going to the Homepage of the portal. When a patient is logged into the portal, they will see a preview on the right of their inbox, which will consist of the subject of the last 5 messages sent to them on the Home Page.
Patient Portal (cont’d)

**Home Tab Includes:**
- Request an appointment
- Send Secure message to your provider
- Request a referral
- Refill Request
- Update my Demographics
- Find a provider (this is a link to http://theuniversitydoctors.com/)
- Print Adult, Pediatric and Demographic forms
- Links to Additional Rowan SOM Information

**Message Center Tab Includes:**
- Request an Appointment
- Send a Message to my Provider
- Request a Referral

**My Medical Record Tab Includes:**
- Personal Information
- Medication
- Pharmacies
- Allergies
- Immunizations
- Health Conditions
- Contacts
- Insurance
- Advance Directives
- Lab Results
- Medications
- Procedures
- Social History (SH)
- Vital Signs
- Chart Summary
- Chart Access History

**Medical Forms Tab Includes:**
- Adult New Patient Form
- Pediatric New Patient Form
- Annual Exam Form
- Past Medical History
- Review of Systems
- Blood Glucose
- Patient BP Reading
- More Medical Forms
- Refill Request
Patient Portal (cont’d)

Contact Us Tab Includes:
- A List of all the Departments

My Account Tab Includes:
- Preferred Method of Contact
- Update Personal Information
- Update Portal Account

EMR

Generating a PIN
The front desk staff must generate a PIN for every patient upon their departure for their appointment. A PIN generator form will be printed upon completion of this encounter type and given to the patient.

Please Note: The PIN will expire in 30 days from the time it was generated. A new PIN will need to be generated after 30 days if a patient has not used the issued PIN number to log into the patient portal. Patients must come into the office to obtain a new PIN number.

Generate a PIN (PIN Generator Encounter Type)

1. Open the patient’s chart.
2. Click the Update icon located on the tool bar.
3. On the Update Chart window, select the PIN Generator as the Encounter Type and click the OK button.
4. Click the Auto Generate button.
5. Click the Close button to close the PIN Generator window to return to the summary screen.
6. Click the End Update icon on the tool bar. Please Note: The Summary prompt will display “Generate Portal PIN”.
7. Click the Sign Document button.
Patient Portal (cont’d)

Printing the PIN for the Patient

8. On the Document Tab, highlight the portal document and click the Print icon located on the tool bar.

9. Under the Documents folder, click Selected Document(s) and click the Print button.

10. Click the Close button to return to the patient’s chart.
Tips/Hints

The Centricity Desktop is a list of documents and messages that need your attention. Your schedule or Appointment Book for the current day appears on your Desktop.

An appointment book is a list of appointments for a provider, a room, or a piece of equipment.

A flag is a message that can send or receive from another Centricity user. Flags are used for information that is not patient related or is not going to be part of a patient's permanent chart. Flags are easily converted into a Document if they need to be a permanent part of a patient’s chart.

A care alert is message that is attached to an individual’s chart. It can be entered as an alert that only displays in the alerts/flags tab and the care alert box on the summary tab of the patient’s chart, or it can also pop up a message when you log into that chart. It can be sent to an individual user, a select group of users, or to everyone. Alerts are easily converted into a Document if they need to be a permanent part of a patient’s chart.

A document is an entry in a patient’s chart that is equivalent to a piece of paper in a paper chart. Documents are typically used to record permanent information in a patient chart.

The Centricity banner appears at the top of the screen and should indicate the name of the user that is logged in to Centricity. **THIS SHOULD ALWAYS BE YOUR NAME IF YOU ARE WORKING IN CENTRICITY.** If this is not your name, click the **EXIT** button on the top right and log back in.
Tips/Hints (cont’d)

A field is a space where information can be entered.

An edit field is a space where any kind of information may be entered.

A drop-down field is a space that provides a list of choices to select from. Some drop-down fields also allow the free text for information that is not on the drop-down list. To activate the drop-down list, you can either begin typing your entry or click on the arrowhead at the end of the field line.

A date field is a space that is formatted to accept dates only. It is accompanied by a calendar to assist with choosing a date. To activate the calendar, click on the grid box at the end of the field line. A calendar will appear. To go back or advance by year, click the double-headed arrow. To go back or advance by month, click the single-headed arrow.

A radio button is a field that can be toggled on or off by clicking in the white circle. A black dot will appear when a radio button has been selected. To de-select, click the radio button again. You can also select and de-select a radio button field by tapping the space bar on your keyboard while in that field.

A check box is a field that indicates selection by the appearance of a check mark. To de-select, click the check box again. You can also select and de-select a check box field by tapping the space bar on your keyboard while in that field.

Use the Tab key on your keyboard to advance to the next field. Use Shift + Tab to move to the previous field.

Use the Ctrl + Home keys on your keyboard to move to the top of the document while in a chart update.

Use Ctrl + End keys on your keyboard to move to the bottom of the document while in a chart update.
Adding Forms, Document Templates and Placeholders

- While in an update, with any form items closed, right mouse click for a menu as seen above.
- Choose Insert>Component to add forms (or click the add forms button on the button bar) and select the text or form component you want to insert.
- To insert a document template (a group of forms), choose Insert>Document Template and select the template you want to insert.
- **Note:** You may also use keyboard shortcuts to speed up the process (i.e. Shift + Ctrl + F4 will insert a dictation placeholder).
- You can also add forms to your “Favorites” pane to retrieve whenever you need them. Click into the “Favorites” pane> rt click> Insert favorite form/text component.

Adding a form as a Favorite

- In the Favorites section, right click and select Add Fav Form/Text Component.
- On the Find Components, type the form you wish to add as your favorites and click **Search**.
- Highlight the desired form from the search results and click **OK**.
Centricity Icon Cheat Sheet

- Allows the users to start a new Flag.
- Allows the user to view multiple schedules.
- Allows the user to select a different view for scheduled.
- Allows the user to send Flags, Alerts, Phone Notes, etc.
- Allows the user to Save Flags, Alerts, Phone Notes, etc. as a draft to send at a later time.
- Allows the user to Cancel Flags, Alerts, Phone Notes, etc.
- Allows the user to reply to Flags, Alerts, Phone Notes, etc.
- Allows the user to Forward Flags, Alerts, Phone Notes, etc.
- Allows the user to Remove Flags, Alerts, Phone Notes, etc.
- Allows the user to convert an Alert/Flag to a Document.
- Allows the user to Sign a Document.
- Allows the user to Save a Document.
- Allows the user to open a Patient’s chart.
- Allows the user to find a Patient’s chart.
- Allows the user to find a different chart.
- Allows the user to exit out of Centricity.
- Allows the user to view the Set Attached information on the History tab.
- Allows the user to view attachments from the Documents tab.
- Allows the user to view the Patient’s registration.
Centricity Icon Cheat Sheet (cont’d)

- Allows the user to make a change to the Patient’s registration.

- Allows the user to view a Graph within a patient’s chart.

- Allows the user to access Handouts for patients.

- Allows the user to enter a Phone Note.

- Allows the user to Close out additional windows/pop-up boxes.

- Allows the user to End any updates.

- Allows the user to finish and sign the documents.

- Allows the user to route to another user or create a new document.

- Allows the user to hold a Document and route at a later time.

- Allows the user to organize documents for viewing purposes.

- This indicates a document lacks a signature.

- Allows the user enter a Refill for a patient.

- Allows the user to print.

- Allows the user to search for another provider.

- Allows the user to route a document.

- Allows the user to access the patient’s Allergies.

- Allows the user to enter information to the Flowsheet.
Centricity Icon Cheat Sheet (cont’d)

- Allows the user to add Problems to a patient’s chart.

- Allows the user to update a patient’s chart.

- Allows the user to save/agree to changes that were made.

- This interaction is Critical and Sever allergy Absolute contraindication Major Drug to drug interaction.

- This interaction is Moderate and Insignificant allergy Possible and Use with caution contraindication at least possible or moderate drug to drug interaction.

- This interaction is Doubtful or Minor drug to drug interaction.

- This interaction is Food (only).

- This interaction is Ethanol (only).

- This interaction is both Food and Ethanol.

- Overrides have been applied to all interaction.

Any additional updates to the manual will be available online. Please refer to our website at http://rowan.edu/som/ist/physiciansys.html